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Overview

Amazon Simple Queue Service (SQS) is a distributed messaging queue service from
Amazon. Messages are composed of text and optional attributes, all of which are supported
by the plug-in. After the messages are sent, they can be received either in batches or one
at a time.

Amazon Simple Notification Service (SNS) is a notification service used for managing and
coordinating the delivery of messages to the subscribing endpoints and clients. The Plug-in
integrates into TIBCO ActiveMatrix BusinessWorks™.

It provides the following features:
e Amazon Connection Shared Resource:

You can use the Amazon connection shared resource to connect to the Amazon SQS or
SNS instance. The shared resource is used by the Amazon SQS and SNS activities.

e SQS and SNS palette:

By using SQS activities, you can create and delete a queue, send messages to a queue,
and receive messages from a queue.

By using SNS activities, you can create and destroy topics, publish messages on the
topics.

Auto and manual delete of messages after they are received.

Plug-in Architecture

The following figure describes the relationship between Amazon SQS or SNS Instance,
TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS, and TIBCO
ActiveMatrix BusinessWorks.
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Amazon SQS and SNS
Plug-in

Amazon SQS or
SNS Instance
TIBCO ActiveMatrix
BusinessWorks

TIBCO Business TIBCO Enterprise
Studio Administrator

The following list describes each item in the Plug-in Architecture figure and the relationship
between them:

* Amazon SQS or SNS instance with which ActiveMatrix BusinessWorks™ Plug-in for
Amazon SQS and SNS communicates.

o ActiveMatrix BusinessWorks Plug-in for Amazon SQS and SNS plugs into ActiveMatrix
BusinessWorks and connects to Amazon SQS or SNS instance.

» ActiveMatrix BusinessWorks is an easy-to-use integration product suite for enterprise
applications.

e TIBCO Business Studio is the graphical user interface (GUI) used by ActiveMatrix
BusinessWorks and the plug-in, to design business processes, and the process engine
is used to execute them.

e TIBCO® Enterprise Administrator provides a centralized administrative interface to
manage and monitor the plug-in applications deployed in an enterprise application.
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Getting Started

A typical workflow for using the plug-in to achieve different goals includes creating a
project, testing it in the debugger, and deploying the application.

TIBCO ActiveMatrix BusinessWorks™ uses the Eclipse graphical user interface (GUI) provided
by TIBCO Business Studio™ to define business processes and generate Enterprise Archives
(EAR files).

The EAR file is then deployed and run in the ActiveMatrix BusinessWorks™ runtime.

The ActiveMatrix BusinessWorks application is managed by using TIBCO® Enterprise
Administrator (TEA).

A basic procedure of using TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS
and SNS includes:

1. Creating a Project
Creating Amazon SQS and SNS Connection Shared Resource

Configuring a Process

> W

Debugging and Running a Process

5. Deploying Applications

Overview of TIBCO Business Studio for
BusinessWorks

TIBCO Business Studio™ for BusinessWorks™ is an Eclipse-based integration development
environment that is used to design, develop, and test ActiveMatrix BusinessWorks
applications. The studio provides a workbench in which you can create, manage, and
navigate resources in your workspace. A workspace is the central location on your
computer where all data files are stored.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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The following table introduces the workbench Ul elements:

Ul Element Description

Menu Contains menu items such as File, Edit, Navigate, Search, Project, Run,
Window, and Help.

Toolbar Contains the following buttons for frequently used commands:

« New [~

+ Save tfu

o Enable/Disable Business Studio capabilities [ -

o Create a new BusinessWorks Application Module T
o Debug As -

e« RunAs O ~

Perspectives Contains an initial set and layout of views that are required to perform a
certain task. TIBCO Business Studio for BusinessWorks launches the Design
perspective by default. Use the Design perspective when designing a
process and the Debug perspective when testing and debugging a process.
To change the perspective, select Window > Open Perspective >
perspective_name from the main menu. Alternatively, click the Open
Perspective & button from the top upper right of the workbench and

select the perspective.

Views Lists the resources and helps you navigate within the workbench. For
example, the Project Explorer view displays the ActiveMatrix BusinessWorks
applications, modules, and other resources in your workspace, and the
Properties view displays the properties for the selected resource. To open a
view, select Window > Show View > view_nameview_name from the main
menu.

Editors Provides a canvas to configure, edit, or browse a resource. Double-click a
resource in a view to open the appropriate editor for the selected resource.
For example, double-click on a process (MortgageAppConsumer.bwp) in the
Project Explorer view to open the process in the editor.
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Ul Element Description

Palette Contains a set of widgets and a palette library. A palette groups activities

that perform similar tasks, and provides quick access to activities when
configuring a process.

Creating a Project

The first task using the plug-in is creating a project. After creating a project, you can add
resources and processes. An Eclipse project is an application module configured for TIBCO
ActiveMatrix BusinessWorks. An application module is the smallest unit of resources that is
named, versioned, and packaged as part of an application.

Procedure

1.
2.
3.

Start TIBCO Business Studio.
Click File > New > BusinessWorks Resources.

In the BusinessWorks Resource dialog box, select BusinessWorks Application
Module and click Next.

Note: There are several ways to open the New BusinessWorks Application
Module dialog box and create a new project in TIBCO Business Studio. For
more information, see TIBCO ActiveMatrix BusinessWorks™ documentation.

In the Project name field, type a name for the project that you are creating.

Select the Use default location, Create empty process, and Create Application
check boxes and click Finish.

Result
A project and an application are created and displayed in the Project Explorer view. The
Process editor opens automatically.
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Creating Amazon SQS and SNS Connection
Shared Resource

The Amazon SQS and SNS Connection shared resource is required by all SQS and SNS
activities as it provides the Amazon Web Services (AWS) client object, which mediates all
interactions with the AWS messaging system.

Procedure
1. In the Project Explorer view, expand the created project, right-click the Resources
folder, and select New > Amazon SQS and SNS Connection.

2. In the Amazon SQS and SNS Connection dialog box. Click Finish, type a name in the
Resource Name field.

3. Configure the Amazon SQS and SNS Connection resource in the editor, as described
in Amazon SQS and SNS Connection Shared Resource.

Configuring a Process

Processes define the business logic. Once a project is created, you have to configure the
process by adding activities, conditions, and services.

Procedure
1. Select an activity from the Palette view and drop it in the Process editor.

For example, select and drop the Timer activity from the General Activities palette
and the CreateQueue activity from the SQS and SNS palette.

2. Select the Timer activity in the Process editor.

3. Click the |_“l icon to create links between the activities and configure the condition
types.
4. Configure the added activities, as described in SQS and SNS Palette.
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o Note: An Amazon SQS and SNS Connection resource is required, when
configuring the activities. For more details, see Creating Amazon SQS and
SNS Connection Shared Resource.

5. Click File > Save.

Debugging and Running a Process

Debug the application you have configured, to ensure that the application configuration is

correct.
Procedure
1. Open the process that you have configured in TIBCO Business Studio™.
2. On the toolbar, click Run > Debug Configurations.
3. In the left panel, click BusinessWorks Application > BWApplication.
4. On the Applications tab of the right panel, ensure that the application you want to
debug and run is selected .
5. Click the Advanced tab and click Browse to locate the logback file.
By default, the log file resides in the TIBCO_HOME /bw/version_
number /config/design/logback directory and error logs are captured.
For more details, see Managing Logs.
6. Click Debug.

TIBCO Business Studio changes to the Debug perspective. Logs are displayed in the
Console view.

Checking Output of an Activity

After debugging the application, you can check the output of activities.

Procedure

1.

In the Debug perspective, expand BWApplication and click the activity in the upper-
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left panel.
2. In the upper-right panel, click the Job Data view and click Output.

Result
The output of the activity is displayed.

Note: You can also check the activity output in the plug-in logs. For more
information, see Managing Logs.

Deploying Applications

After deploying applications, you can manage BusinessWorks applications by using TIBCO
Enterprise Administrator.

Before you begin
The following tasks are required before deploying applications:

e Creating a Project.
e Generating an EAR File.

A complete workflow of deployment includes:

Procedure
1. Upload an EAR file.

2. Deploy an application.
3. Configure an application.

4. Start an application.

You can deploy an application EAR file by using the command-line mode with the
bwadmin utility. For more information about how to deploy an application, see
TIBCO ActiveMatrix BusinessWorks Administration guide.
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Generating an EAR File

Application archives are enterprise archive (EAR) files that are created in the TIBCO
Business Studio™. An EAR file is required when deploying an application.

Before you begin
An application project has already been created, as described in Creating a Project.

Note: There are many ways to generate an EAR file. The following procedure is
one of the methods. For more information, see TIBCO ActiveMatrix BusinessWorks

Administration guide.

Procedure
1. Go to the File Explorer view and click the Open Directory to Browse % icon.
2. Select the folder where you want to generate the EAR file and click OK.
The new folder is displayed in the File Explorer view.

3. Drag the application from the Project Explorer view to the new folder in the File
Explorer view.

The EAR file is generated with the name <name>. <application>_<version>.ear.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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Amazon SQS and SNS Connection Shared
Resource

This Amazon SQS and SNS Connection shared resource is required by all SQS and SNS
activities as it provides the AWS client object that mediates all interactions with the AWS
messaging system.

General

This section includes the following fields:

Field Module Description
Property?
Package No Name of the package. By default, the value of the field is the

name of the package in which the resource is created. You
can change the field value by clicking icon.

Name No Name of the connection. You can change the field value by
clicking icon.

Description No The user can provide additional description about the
connection.

SQS SNS Client Configuration

You can provide information required to establish the connection with Amazon SQS and
SNS. You can configure the connection using AWS Credential, SAML Authentication, or
Container Credentials.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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o Note: To enable the AWS regional endpoint for STS (Security Token Service), set
the JVM argument as:

—-Dcom. tibco.aws.useregionalendpoint=true

o Note: To successfully test the connection for Custom Endpoint on Private VPC
use com.tibco.aws.useregionalendpoint=true in the
tibcohome\studio\<version>\eclipse\Configuration\config.ini file.

The following table describes the fields:

Condition Field Module Description
Applicable Propert
y?
N/A AWS Region Yes The name of the AWS region to which you want to
Name connect. For a complete list of regions, see AWS

documentation.

N/A Authenticati Yes You can use the following types of authentication:

on Type e AWS Credential

e SAML Authentication

¢ Container Credentials

* Default Credentials Provider Chain
Note: Container Credentials authentication
type is loaded from the Amazon ECS when the
environment variable AWS_CONTAINER_
CREDENTIALS_RELATIVE_URI is set. For

information on Amazon ECS container
credentials, see AWS documentation.

Available AWS Key ID  Yes This is the ID of the secret key for AWS. Keys can
only when be created through the AWS console and

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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Condition
Applicable

the
Authenticati
on Type is
selected as
AWS
Credential.

Available
only when
the
Authenticati
on Type is
selected as
AWS
Credentials
or Container
Credentials
and Cross
Account
Access

Module
Propert

y?

Field

AWS Secret Yes

Session Yes
Token

Cross Yes
Account

Access

Role ARN Yes

Description

downloaded as csv files.
This is the encrypted secret key for access to AWS.

Along with AWS Key ID and AWS Secret the plug-in
now supports the Session Token field. Session
Token is the temporary security credentials.

Note: When the Session Token is provided the
AWS credentials are treated as temporary
session credentials otherwise they are static
IAM credentials.

Use the AWS Security Token Service (AWS STS) to
create and provide trusted users with temporary
security credentials that can control access to
your AWS resources. This parameter uses cross-
account access temporary security credentials
created by AssumeRole. For information on
Temporary Security Credentials, see AWS
documentation.

The Amazon Resource Name (ARN) of the role to
assume. For more information on RoleARN, see
AWS documentation.
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Condition
Applicable

check-box is
selected

Available
only when
the
Authenticati
on Type is
selected as
SAML
Authenticati
on.

Field

Module
Propert

y?

Role Session Yes

Name

External ID Yes

Expiration Yes
Duration

(min)

Identity

No

Provider

(IdP)

Description

An identifier for the assumed role session used to
uniquely identify a session when the same role is
assumed by different principals or for different
reasons. For more information on
RoleSessionName, see AWS documentation.

A unique identifier that might be required when
you assume a role in another account. It is used
to address the confused deputy problem. For
more information on Externalld, see AWS
documentation.

Parameter to specify the duration in minutes for
which the temporary security credentials remain
valid using AssumeRole. For more information on
ExpirationDuration, see AWS documentation.

The service provider that manages your user
identities. With an IdP, you can manage user
identities outside of AWS instead of creating AWS
Identity and Access Management (IAM) users in
your account. After establishing the trust
relationship between IdP and AWS, your users can
access AWS resources using their corporate
credentials. The following identity providers can
be used:

e PingFederate
e ADFS

Note: Ensure that Form authentication is
enabled for the identity provider.
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Condition Field Module Description
Applicable Propert
y?

Note: While using ADFS IdP, if the Windows
Integrated Authentication (WIA) is enabled and
ADFS IdP is accessible via Intranet, then set the
Dcom.tibco.bw.awsplugins.saml.useragent=
Javal.8 system property to fallback to Form
authentication. For more information, see
ADFS doc.
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Condition
Applicable

Field

Identity
Provider
Login URL

Username

Password

AWS Role

Token
Expiration
Duration

SSL Client
Configuratio
n

Module
Propert

y?

Yes

Yes

Yes

Yes

Yes

No

Description

IdP login URL that is generated when you
configure the identity provider in the identity
provider console.

Example URL for PingFederate:
https://<host>:<port>
/idp/startSSO.ping?PartnerSpld=urn%3Aamazon%
3Awebservices

Example URL for ADFS:
https://<host>:<port>/adfs/|s/
IdplnitiatedSignOn.aspx? loginToRp=urn:amazon:
webservices

User name that is configured with your identity
provider

Password that is configured with your identity
provider

AWS |IAM role
Duration for which the token is valid

Note: This is configured in AWS IAM policy
when creating the role. If the user specifies the
value as 0, the value is taken as 60 minutes.

Establishes secure connection with the identity
provider

For more information about SSL Client
Configuration, see the "Shared Resource" section
of the TIBCO ActiveMatrix BusinessWorks™ Bindings
and Palettes Reference guide.
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Condition Field Module Description
Applicable Propert
y?
Use Proxy Yes The call to the identity provider through the proxy

can be enabled when using Advanced
configuration with a custom client type.

Note: To enable basic authentication, set JVM
argument as

-Djdk.http.auth.tunneling.disabledSchemes=

For more information, see setting bwappnode-
<AppNodeName>.tra file in "Setting JVM
Parameters for the AppNode Manually" section
in the TIBCO ActiveMatrix BusinessWorks
documentation.

With TIBCO BusinessStudio for BusinessWorks :
Add this argument in <BW_
HOME>\studio\<version>\eclipse\TIBCOBusines
sStudio.ini file.

N/A Custom Yes The Custom Endpoint is the URL of the entry
Endpoint point for an AWS web service. It serves as a
gateway for accessing AWS SQS and SNS.

Note: For Custom Endpoint the AWS Region
Name field is mandatory for the shared
resource.

Note: Use the following property if the Cross
Account Access checkbox is selected and the
deployment environment is in a Virtual Private
Cloud.

-Dcom.tibco.aws.useregionalendpoint=true

Custom Client Config

SQS Default Client Config chooses a predefined configuration or creates a custom
configuration.
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Note: The DynamoDB and SimpleWorkFlow configurations are provided in case
the client defaults for those clients who closely match your desired
configuration.

For other situations where the default configuration is not optimal, use the custom
configuration. You can configure the HTTP proxy in the custom configuration. For more
information about setting a proxy, see Setting Proxy.

For detailed descriptions of custom configuration, see Client Configuration on AWS
documentation.
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Hot Update of Shared Resource

You can use the Hot Update feature to update application module properties and the
TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS Connection Shared
Resource module property without restarting the application. The feature works for the
following fields in the shared resource:

Access Key
Secret Key

Role ARN

Session Token
Custom Endpoint

Cross Account Access

For more information, see the "Hot Update of Application Module Properties and Module
Property for JDBC Shared Resource" topic in the TIBCO BusinessWorks™ Container Edition
Application Development guide.
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SQS and SNS Palette

The SQS and SNS palette contains activities that you can add to your business processes.

The palette contains the following shared connection:
Amazon SQS and SNS Connection Shared Resource
The palette also contains the following activities:

e Create Queue

¢ Delete Queue

e Get Queue Message

e Put Queue Message

* Receive

e Inquire Queues

e Create Topic

e Destroy Topic

e Publish

Create Queue

The CreateQueue activity is used to create an SQS queue.
General

On the General tab, select shared resource to establish a connection to the Amazon server.
The following table lists the configurations on the General tab of the CreateQueue activity.

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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Field Module Description
Property?
Name No
SQS Yes
Client
Resource ic
Description

on &,

Specify a name for the activity in the process definition.

Select SQS Client configuration either from an existing resource or
create a new resource, by using the Choose/Create Default

On the Description tab, provide a short description for the CreateQueue activity.

Input

On the Input tab, specify input values for the CreateQueue activity. The following table
lists the input elements on the Input tab of the CreateQueue activity.

Input Item

QueueName

FIFOQueue

ContentBasedDeduplication

DelaySeconds

Data Type

String

Boolean

Boolean

Int

Description

Required. The name of the queue to
create. This name is incorporated into
the queue URL returned.

Optional. This flag must be set to true if
the user wants to create the FIFO (First-
in-First-out) queue. The name of the
queue must have .fifo as a suffix.

Optional. This field is used for enabling
or disabling content based deduplication
for the FIFO queue.

Optional. The time in seconds for which
the delivery of all messages in the queue
is delayed.

Value range: 0 to 900 seconds (15
minutes)
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Input Item

MaximumMessageSize

MessageRetentionPeriod

Policy

ReceiveMessageWaitTimeSeconds

RedrivePolicy

Data Type

Int

Int

String

Int

String

Description
Default value: 0

Optional. The number of bytes a
message can contain before Amazon SQS
rejects it.

Integer value range: 1024 bytes (1 KiB)
up to 262144 bytes (256 KiB)

Default value: 262144 (256 KiB)

Optional. The number of seconds for
which Amazon SQS retains a message.

Integer value range:60 seconds (1
minute) to 1209600 seconds (14 days)

Default value:345600 seconds (4 days)

Optional. The queue's policy. A valid
AWS policy. For more information about
policy structure, see Overview of AWS
IAM Policies in the Amazon IAM User
Guide.

Optional. The time for which a
ReceiveMessage call wait for a message
to arrive.

Integer value range: 0 to 20 (seconds)

Default value: 0

Optional. The parameters for dead letter
queue functionality of the source queue.
For more information about
RedrivePolicy and dead letter queues,
see Using Amazon SQS Dead Letter
Queues in the Amazon SQS Developer

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide
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Input Item Data Type Description
Guide.
VisibilityTimeout Int Optional. The visibility timeout for the

queue is a period of time, during which
SQS prevents other consuming
components from receiving and
processing that queue.

Integer value: 0 to 43200 seconds (12
hours)

Default value: 30 seconds
Permissions Complex Optional. Permissions contribute to the
policy for the queue. Permissions permit

queues to be shared with other
principles (userlDs).

Label String An arbitrary label for the permission.

Accountld String One or more Amazon Account IDs for
which the permission is to be applied.

Action String One or more actions the client wants to
allow for the specified principals. The
following values are valid values:

* | SendMessage | ReceiveMessage |
DeleteMessage | ChangeMessageVisibility
| GetQueueAttributes | GetQueueUrl

Note: You must fill out either none or all of the following fields: Label,
Accountld, and Action.

Output

On the Output tab, find the output value of the CreateQueue activity. The following table
lists the output elements on the Output tab of the CreateQueue activity.
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Output Item Data Type Description
QueueName String Provides the queue name from the input schema.
QueueUrl String The URL for the created SQS queue.

Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.

ErrorCode String The plug-in error code for the exception. For more information,
see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Delete Queue

The SQS DeleteQueue activity deletes a queue from the AWS backend.

General

On the General tab, you can establish a connection to the Amazon server. The following
table lists the configurations on the General tab of the DeleteQueue activity.

Field Module Description
Property
Name No Name to be displayed as a label for the activity in the process.
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Field Module Description

Property
SQS Yes Select SQS Client configuration either from an existing resource or
Client create a new resource, by using the Choose/Create Default

Resource icon & .

Purge No Select to delete the messages in a queue.

Queue
Note: This operation deletes only the messages in the queue
but not the queue itself.

Description

On the Description tab, you can provide a short description for the DeleteQueue activity.

Input

On the Input tab, you can specify input values for the DeleteQueue activity. The following
table lists the input element on the Input tab of the DeleteQueue activity.

Input Item Data Type Description
QueueName String Required. The name of the queue to be deleted.
Output

This activity does not generate any output.

Fault

The Fault tab lists exceptions that are generated by this activity.
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Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.

ErrorCode String The plug-in error code for the exception. For more information,
see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. This frequently
contains the error message from the AWS SQS API call that
failed.

Get Queue Message

This activity is used to receive one or more messages from an SQS Queue. The
GetQueueMessage activity can be configured to use long polling by setting the WaitTime to
be greater than zero (0). However, the activity returns almost immediately, when there are
messages on the queue. The number of messages returned are usually smaller than the
MaxMessages parameter (unless it is 1) and it is usually necessary to loop on the Get
Queue Message to retrieve all the messages in the queue. This is normal within the
context of SQS messaging. The only time that the activity is blocked for the full WaitTime
period, is when the queue is empty.

General

On the General tab, select shared resource to establish a connection to the Amazon server.
The following table lists the configurations on the General tab of the GetQueueMessage
activity.

Field Module Description
Property?
Name No Name to be displayed as a label for the activity in the
process.
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Field Module Description
Property?
SQS Client Yes Select SQS Client configuration either from an existing

resource or create a new resource, by using the
Choose/Create Default Resource icon &/,

ManualDelete No If enabled, use confirm activity to delete the messages. By
default, the check box is not selected.

Caution:
Always use confirm activity to delete messages within

visibility timeout. If the messages are deleted after
visibility timeout, there could be an exception or
duplicate messages are received.

Description

On the Description tab, provide a short description for the GetQueueMessage activity.

Input

On the Input tab, you can specify input values for the GetQueueMessage activity. The
following table lists the input elements on the Input tab of the GetQueueMessage activity.

Input Item Data Description
Type
QueueName String Required. The name of the queue from which messages are to
be received.
MaxMessages Int Optional. Indicates the maximum number of messages to be

received in one operation. The default value is 1 and the
maximum value is 10.

WaitTime Int Optional. The duration (in seconds) for which the call waits for

a message to arrive before returning. If no message arrives in
the allowed time, an SQSException is thrown indicating that a
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Input Item Data
Type
PollingInterval Int
Output

Description

timeout condition has occurred. If Amazon server is down,
plug-in keeps trying to reconnect to the server till WaitTime.

Optional. The duration after which plug-in tries to reconnect to
the server before timeout.

On the Output tab, find the output value of the GetQueueMessage activity. The following
table lists the output elements on the Output tab of the GetQueueMessage activity.

Output Item
SgsMessage
Senderld

Messageld

SentTimeStamp
Body

MessageGroupld

MessageDeduplicationld

SequenceNumber

MessageAttrs

Data Type
Complex
String

String

String
String

String

String

String

Complex

Description
Encodes 1 to 10 messages.
Returns the IAM Role or user ID of the sender.

The message ID assigned to the message when it
was originally sent.

The timestamp when the message was sent.
The message body.

It specifies that a message belongs to a specific
message group.

It is used for avoiding a duplication of the sent
messages.

The large, non-consecutive number that Amazon
SQS assigns to each message.

Encodes the message attributes to be sent as part
of the message. Each attribute is composed of a
Name, Type, and Value.
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Output Item Data Type Description

Name String The name of the attribute.

Type String The type of the attribute.

Value String A string representation of the attribute value.
Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.

ErrorCode String The plug-in error code for the exception. For more information,
see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Put Queue Message

The PutQueueMessage activity puts a message on the SQS queue.

General

On the General tab, select shared resource to establish a connection to the Amazon server.
The following table lists the configurations on the General tab of the PutQueueMessage
activity.
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Field Module Description

Property?
Name No Name to be displayed as a label for the activity in the process.
SQS Yes Select SQS Client configuration either from an existing resource or
Client create a new resource, by using the Choose/Create Default

Resource icon & .

Description

On the Description tab, provide a short description of the PutQueueMessage activity.

Input

On the Input tab, specify input values for the PutQueueMessage activity. The following
table lists the input elements on the Input tab of the PutQueueMessage activity.

Input Item Data Type Description

QueueName String Required. The name of the queue on which the
message is to be placed.

MessageGroupld String Optional. Required for FIFO queue only. It
specifies that a message belongs to a specific
message group.

MessageDeduplicationld String Required when ContentBasedDeduplication is set
as False. Optional when
ContentBasedDeduplication is set as True. It is
used for avoiding a duplication of a sent message.

SgsMessage Complex Required. Encodes the body and attributes of the
message.

Body String Required. The message body.

MessageAttrs Complex Encodes the message attributes to be sent as part
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Input Item Data Type Description

of the message. Each attribute is composed of a
Name, Type, and Value.

Name String The name of the attribute.
Type String The type of the attribute. The attribute types
supported are:
e String
e Number
e Binary

e Custom Attribute type: For example,
String.Employeeld. For more information,
see AWS documentation.

Value String A string representation of the attribute value.

Note: Provide Base64 encoded string as input
when the attribute of the Type field is Binary.

Output

On the Output tab, find the output value of the PutQueueMessage activity. The following
table lists the output element on the Output tab of the PutQueueMessage activity.

Output Item Data Type Description
Messageld String Contains the message identifier for the message.
Fault

The Fault tab lists exceptions that are generated by this activity.
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Fault Data
Type
SQSException N/A

ErrorCode String

ErrorMessage String

Receive

Description
Any exception generated by the activity after execution. It has
the following fields: ErrorCode and ErrorMessage.

The plug-in error code for the exception. For more information,
see Error Codes topic.

The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

This is an event source activity that starts a TIBCO ActiveMatrix BusinessWorks™ process
when one or more messages are received.

General

Because an event source has no input transition, all parameters for the receiver are static
literals, process properties, or module properties.

Field

Name

SQS Client

QueueName

Module Description
Property?
No Name to be displayed as a label for the

activity in the process.

Yes Select SQS Client configuration either from
an existing resource or create a new resource
by clicking the Choose/Create Default
Resource icon &,

Yes Required. This is the queue on which the
receiver listens.
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Field Module Description
Property?
Maximum Messages Yes Required. Enter the number of messages to

be processed by each newly created
ActiveMatrix BusinessWorks™ job. The
minimum value is 1, and the maximum value
is 10.

ManualDelete No If enabled, use the confirm activity to delete
messages. By default, the check box is not
selected.

Caution: During the visibility timeout, use
the confirm activity to delete messages.
Deleting messages after visibility timeout
might cause exceptions or duplicate
messages.

Create Queue If Not Exist No If enabled, the receiver creates a queue with
the default configuration, if the named
queue does not exist. The queue is owned by
the AWS ID specified on the SQS Client
shared resource and cannot be accessed by
others. By default, the check box is not
selected.

ContentBasedDeduplication No This check box appears only when
QueueName is entered and Create Queue If
Not Exist check box is selected. This check
box is applicable for FIFO queue only.

Description

On the Description tab, provide a short description for the Receive activity.

Advanced

The Advanced tab has the following fields:
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Field Description

Sequence Optional. This field can contain an XPath expression that specifies the order in

Key which processes should run. Process instances with sequencing keys that
evaluate to the same value are run in the order, the process instances were
created.

Custom Job  Optional. This field can contain an XPath expression that specifies a custom ID
Id for the process instance.

Input

There are no input fields for the activity.

Output

On the Output tab, find the output value of the Receive activity. The following table lists
the output elements on the Output tab of the Receive activity.

Output Item Data Type Description

ReceiveOut Complex Serves as an anchor node for multiple SqsMessage
nodes. SqsMessages ranging from 1 to 10 might be
sent as an input to a new job.

SgsMessage Complex Encodes up to 10 messages.
Senderld String Returns the IAM Role or user ID of the sender.
Messageld String The message ID assigned to the message when it

was originally sent.

SentTimeStamp String The time stamp when the message was sent.
Body String The content of the message.
MessageGroupld String It specifies the message group to which the

message belongs.
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Output Item Data Type Description

MessageDeduplicationld String It is used for avoiding a duplication of sent
messages.

SequenceNumber String The large, nonconsecutive number that the

Amazon SQS assigns to each message.

MessageAttrs Complex Any message attributes that were included with
the message. Each attribute is composed of a
Name, Type and Value.

Name String The name of the attribute.

Type String The type of the attribute.

Value String A string representation of the attribute value.
Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after the execution. It

has the following fields: ErrorCode and ErrorMessage.

ErrorCode String The plug-in error code for the exception. For more information,
see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Inquire Queues

The InquireQueue activity queries the queue to discover its attributes and message depth.
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General

On the General tab, select shared resource to establish a connection to the Amazon server.
The following table lists the configurations on the General tab of the InquireQueue
activity.

Field Module Description

Property?
Name No Name to be displayed as a label for the activity in the process.
SQS Yes Select SQS Client configuration either from an existing resource or
Client create a new resource, by using the Choose/Create Default

Resource icon & .

Description

On the Description tab, provide a short description for the InquireQueue activity.

Input

On the Input tab, specify input values for the InquireQueue activity. The following table
lists the input element on the Input tab of the InquireQueue activity.

Input Item Data Description
Type
QueueName String Required. The name of the queue from which properties are to

be retrieved.

Output

On the Output tab, find the output value of the InquireQueue activity. The following table
lists the output elements on the Output tab of the InquireQueue activity.
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Output Item Data Type Description

QueueName String A copy of the input schema
QueueName.

QueueUrl String The URL of the named queue.

ApproximateNumberOfMessages Int The approximate number of

messages on the queue.

ApproximateNumberOfMessagesNotVisible Int The approximate number of
messages that are currently
hidden. This happens when a
client receives a message and
when deletes it.

VisibilityTimeout Int The number of seconds a
message can be hidden before it
becomes visible, regardless of
the actions of the client that
received it.

CreatedTimeStamp String The times stamp of when the
queue was created.

LastModifiedTimeStamp String The time stamp of when the
queue was most recently
modified.

Policy String Any security policies in place for
the queue.

MaximumMessageSize Int The maximum message size

permitted for the queue.
MessageRetentionPeriod Int The duration (in seconds) for

which a message remains on the
queue before being deleted.
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Output Item Data Type Description

QueueArn String The Amazon Resource Name for
the queue.

ApproximateNumberOfMessagesDelayed Int The approximate number of

messages which have been
placed on the queue, for which
there is a delay in effect, such
that they are not yet visible.

DelaySeconds Int The duration (in seconds) for
which the delivery of all
messages in the queue is
delayed.

ReceiveMessageWaitTimeSeconds Int The duration for which a
ReceiveMessage call must wait
for a message to arrive.

RedrivePolicy String The parameters for dead letter
queue functionality of this
queue.

ContentbasedDeduplication Boolean For FIFO queue, it displays

whether content-based
deduplication is enabled or
disabled.

Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.
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Fault Data Description
Type
ErrorCode String The plug-in error code for the exception. For more information,

see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Create Topic

The CreateTopic activity is used to create the SNS topic. If the topic already exists, then its
topicARN is returned. You can also create FIFO topics using this activity.

General

On the General tab, you can select a shared resource to establish a connection to the
Amazon server. The following table lists the configurations on the General tab of the
CreateTopic activity.

Field Module Description
Property?
Name No Name to be displayed as a label for the activity in the process.
SNS Yes The SNS activities use the same client shared resource
Client configuration as the SQS activities. Select SNS Client configuration

either from an existing resource or create a new resource, by using
the Choose/Create Default Resource icon & .

Description

On the Description tab, provide a short description of the CreateTopic activity.
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Input

On the Input tab, specify input values for the CreateTopic activity. The following table lists
the input elements on the Input tab of the CreateTopic activity.

Input Item Data Type Description

Name String Required. The name of the topic to be created.
This name is incorporated into the TopicARN
value returned.

Permissions Complex Permissions contribute to the policy for the
queue. Permissions control whether queues
can be shared with other principles (userIDs).

Label String An arbitrary label for the permission.

Accountld Int One or more Amazon Account IDs for which
the permission is to be applied.

Action String One or more actions the client wants to allow
for the specified principals. The following
values are valid values:

Publish | Subscribe | Receive.
ContentBasedDeduplication Boolean Applicable only for FIFO topics. You can use

this input to enable content-based
deduplication. The default value is false.

Note: You must fill out either none or all of the following fields: Label,
Accountld, and Action.

Output

On the Output tab, find the output value of the CreateTopic activity. The following table
lists the output element on the Output tab of the CreateTopic activity.
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Output Data Description
Item Type

TopicARN String The AWS Resource Name for the newly created topic. This is the
value that must be used when publishing to or deleting the topic.

Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.

ErrorCode String The plug-in error code for the exception. For more information,
see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Destroy Topic

The DestroyTopic activity is used to delete an SNS topic.

General

On the General tab, select shared resource to establish a connection to the Amazon server.
The following table lists the configurations on the General tab of the DestroyTopic
activity.
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Field Module Description

Property?
Name No Name to be displayed as a label for the activity in the process.
SNS Yes Required. The SNS activities use the same client shared resource
Client configuration as the SQS activities. Select SNS Client

configuration from an existing resource or create a new resource
by using the Choose/Create Default Resource icon & .

Description

On the Description tab, provide a short description for the DestroyTopic activity.

Input

On the Input tab, specify input values for the DestroyTopic activity. The following table
lists the input elements on the Input tab of the DestroyTopic activity.

Input Item Data Type Description
TopicARN String Required. The Amazon Resource Name for the topic.
Output

The activity has no output schema. If the delete operation fails, an exception is generated.

Fault

The Fault tab lists exceptions that are generated by this activity.

Fault Data Description
Type
SQSException N/A Any exception generated by the activity after execution. It has

the following fields: ErrorCode and ErrorMessage.
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Fault Data Description
Type
ErrorCode String The plug-in error code for the exception. For more information,

see Error Codes topic.

ErrorMessage String The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Publish

The Publish activity is used to publish a message on an SNS Topic. You can also publish
messages to FIFO topics using this activity.

General

On the General tab, you can select shared resource to establish a connection to the
Amazon server. The following table lists the configurations on the General tab of the
Publish activity.

Field Module Description

Property?
Name No Name to be displayed as a label for the activity in the process.
SNS Yes Required. The SNS activities use the same client shared resource
Client configuration as the SQS activities. Select SNS Client configuration

either from an existing resource or create a new resource, by using
the Choose/Create Default Resource icon® .

Description

On the Description tab, you can provide a short description for the Publish activity.
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Input

On the Input tab, you can specify input values for the Publish activity. The following table
lists the input elements on the Input tab of the Publish activity.

Input Item Data Type Description

TopicARN String Optional. The Amazon Resource Name for the
topic. Either TopicARN, TargetARN or
PhoneNumber must be specified but not all.

TargetARN String Optional. The Amazon Resource Name for the
endpoint to which you want to publish the output.
Either TopicARN, TargetARN or PhoneNumber
must be specified but not all.

Subject String Optional. The value to be used as the subject line
when the message is delivered to email endpoints.

MessageStructure String Optional. Set MessageStructure to JSON, if you
want to send a different message for each
protocol.

PhoneNumber String Optional. Specify the phone number using the

E.164 format to send an SMS message. If you don't
specify a value for the PhoneNumber parameter,
you must specify a value for the TargetARN or
TopicARN parameters. For more details about
Sending an SMS Message and configuring the
message attributes, see Sending an SMS Message.

SnsMessage String The message you want to send to the topic.
Body String Required. Content of the message.
MessageAttrs Complex Optional. Any message attributes that were

included with the message. Each attribute is
composed of a Name, Type, and Value.
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Input Item Data Type Description
Name String The name of the attribute.

Type String The type of the attribute. The attribute types
supported are:

e String
e Number
e Binary

e String.Array

Note: String.Array type expects comma-
separated values. To map the activity input,
use the following XPath function: tib:concat-
sequence-format (<String-repeating-
element>, ",").

Value String A string representation of the attribute value.

Note: Provide Base64 encoded string as input
when the attribute of the Type field is Binary.

MessageGroupld String Applicable only for FIFO topics. You must provide
an ID, which specifies that the message belongs to
a particular group. For more information, see AWS
documentation.

MessageDeduplicationld String Applicable only for FIFO topics. If you create a
topic without content-based deduplication, a
unique ID must be provided to prevent
duplication. For more information, see AWS
documentation.

Output

On the Output tab, you can find the output value of the Publish activity. The following
table lists the output element on the Output tab of the Publish activity.
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Output Item Data Type
Messageld String
Fault

Description

Contains the message identifier for the message.

The Fault tab lists exceptions that are generated by this activity.

Fault Data
Type

SQSException

ErrorCode String

ErrorMessage String

Description
Any exception generated by the activity after execution. It has
the following fields: ErrorCode and ErrorMessage.

The plug-in error code for the exception. For more information,
see Error Codes topic.

The plug-in error message for the exception. It contains the
error message from the AWS SQS API call that failed.

Sending an SMS Message

You can send a message directly to the phone number without subscribing the phone
number to an Amazon SNS topic. You can use the MessageAttrs to set the values for the

following attribute names:

Name

AWS.SNS.SMS.SenderID

Type Value

String A custom ID that contains up to 11 alphanumeric

characters, including at least one letter and no
spaces. The sender ID is displayed as the message
sender on the receiving device. If the SenderID is not
defined, then the default SenderlD is used. For the
countries and regions that support sender IDs, see
Supported Regions and Countries.
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Name Type Value

AWS.SNS.SMS.MaxPrice String The maximum amount in USD that you are willing to
spend to send an SMS message.

Note: The message is not sent if the cost of
sending the message exceeds the amount
specified in the MaxPrice.

AWS.SNS.SMS.SMSType String The type of message that you are sending:

e Promotional- Noncritical messages, such as
marketing messages. Amazon SNS optimizes
the message delivery to incur the lowest cost.

Note: By default, Promotional is used as a
value for MessageAttrs.

e Transactional- Critical messages that support
customer transactions, such as one-time
passcodes for multi-factor authentication.
Amazon SNS optimizes the message delivery to
achieve the highest reliability.
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Working with Sample Projects

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS is packaged with a
sample project. After installing the plug-in, you can navigate to the sample projects located
at TIBCO_HOME\bw\palettes\awsm\<version>\samples.

Importing Sample Projects

To run sample projects, you must first import them to TIBCO Business Studio™.

Procedure
1. Start TIBCO Business Studio.

2. Click File > Import.

3. In the Import dialog box, expand the General folder and select the Existing Studio
Projects into Workspace item, and click Next.

4. Click Browse next to the Select archive file field, select the samples that you want
to import, and click Finish.

Configuring Module Properties

After importing the SqsSnsSamples.zip file, you must configure the module properties in
TIBCO Business Studio™ and then run the processes. The module properties includes aws_
key, secret_key, and aws_region, which is used to connect Amazon instance.

1. In the Project Explorer view, double-click Module Descriptors > Module Properties

* In the Module Properties pane, configure the module property values.
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= Module Properties

Properties

Property Configurations

User System

Groups / Properties Type default
E aws_key B¢ String <your aws key=
Ed secret_key Password taanans
Ed aws_region BB String <aws region:=

2. On the toolbar, click the Save icon .

Configuring SNS Sample Process

The sns package has one process that explains the usage of SNS activities

Before you begin
Ensure that the project is imported successfully and the process associated with the sns
package does not contain errors.

SNSPublishResource.bwp

This process creates a topic, publishes a message, and deletes the topic.

SendMessageResource.bwp

This process sends a message directly to the phone number.

Configuring SQS Sample Processes

The sqs package has five processes that explain the usage of SQS activities.
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Before you begin
Ensure that the project is imported successfully and the processes associated with sqs
package do not contain any error.

CreatePutGetDeleteResource.bwp

This process performs the following tasks:
e Creates a standard or FIFO queue.
e Puts a message on the queue.
» Reads a message from the queue.

e Deletes the queue.

RequestResponse.bwp

The TestRequestResponse.bwp process triggers this process. This process performs the
following task:

e Uses receiver as starter activity and then puts a reply to the other queue.

SgsMessageAttrsResource.bwp

This process performs the following tasks:
e Creates a standard queue.
» Puts a message in the queue with message attributes.
» Reads the message from the queue.

e Deletes the queue.

TestRequestResponseResource.bwp

This process performs the following tasks:
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Creates a standard queue.
Puts a message on the queue which triggers the receiver in RequestResponse.bwp.
Reads the message from the queue.

Deletes the queue with the wait time configuration.

Running the Sample Project

You can run the process in the sample project to see how to perform different operations.

Before you begin

Ensure that you have imported the sample project to TIBCO Business Studio as described
in the Importing Sample Projects section and configured module properties as described in
the Configuring Module Properties section.

Procedure

1.
2.

In the TIBCO Business Studio™, click Run > Run Configurations.

In the Run Configurations window, expand BusinessWorks Application and click BW
Application.

On the right pane, click the Applications tab and select the
SgsSnsSamples.application check box.

Check boxes for all of the processes from SqsSnsSamples.application are selected.
Click Run to run the process.

Run lrestdoc command from console tab.

This command gives the REST endpoint for the process. You can get the URL on the
console tab.

Run the URL in the browser.
The swagger Ul page is displayed in the browser.

Provide parameters and values as shown in the Example value.

Click the Try it out button to run the process.
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9. Click the Terminate icon to stop the process.
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Managing Logs

When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.

A logback.xml file is located at TIBCO_HOME\bw\version_number\config\design\logback.
By default, error logs are displayed in the Console view when you run a process in debug
mode. You can change the log level of the plug-in to trace different messages and export
logs to a file. Different log levels correspond to different messages as described in Log
Levels. For more information, see Setting Up Log Levels.

Log Levels

The plug-in captures logs at different levels. The level tag defines the log level.

Log
Level

Info

Warn

Error

Debug

Trace

Description

Indicates normal plug-in operations. No action is needed. A tracing message
tagged with Info indicates that a significant processing step is reached and logged
for tracking or auditing purposes. Only info messages preceding a tracking
identifier are considered as significant steps.

Indicates that an abnormal condition is found. Processing continues, but special
attention from an administrator is recommended.

Indicates that an unrecoverable error has occurred. Depending on the error
severity, the plug-in may continue with the next operation or may stop altogether.

Indicates a developer-defined tracing message.

Includes all the information regarding the running process.
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Setting Up Log Levels

By default, the log level is Error . You can change the log level to trace different messages.

o Note: If neither the plug-in log nor the BusinessWorks log is configured in the
logback. xml file, the error logs of the plug-in are displayed in the Console view
by default.

If the plug-in log is not configured but the BusinessWorks log is configured in the
logback. xml file, the configuration for the BusinessWorks log is implemented by
the plug-in.

Procedure
1. Navigate to the TIBCO_HOME\bw\version\config\design\logback directory and open
the logback.xml file.

2. Add the following node in the Console Appender area to specify the log level for the
plug-in.
For SQS:
<logger name="com.tibco.tci.plugin.aws.sqgs.runtime">

<level value="DEBUG"/>
</logger>

For SNS:

<logger name="com.tibco.tci.plugin.aws.sns.runtime">
<level value="DEBUG"/>
</logger>

The level tag defines the log level and the value is TRACE, DEBUG, INFO, WARN or
ERROR.

Note: When the level is set to Debug, the input and output for the plug-in
activities are also displayed in the Console view. For more details, see Log
Levels.

3. To set the log level for an activity, use the following node:

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide



57 | Managing Logs

<logger

name="com.tibco.tci.plugin.aws.

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

y|l>

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

<level value="DEBUG"/>
</logger>
<logger

name="com. tibco.tci.plugin.aws.

y|l>

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

y|l>

<level value="DEBUG"/>
</logger>
<logger

name="com.tibco.tci.plugin.aws.

<level value="DEBUG"/>
</logger>

sgs.

sgs.

sgs.

sgs.

sgs.

sns.

sns.

sns.

runtime.

runtime.

runtime.

runtime

runtime.

runtime.

runtime.

runtime.

create.CreateActivity">

delete.DeleteActivity">

inquire.InquireActivit

.put.PutActivity">

receive.ReceiveActivit

create.CreateActivity">

destroy.DestroyActivit

publish.PubActivity">

Note: Activities that are not configured with specific log levels, still inherit
the log level configured for the plug-in or TIBCO ActiveMatrix

BusinessWorks™ .

If you want to set the log level of the Amazon SQS and SNS Shared Resource to

Debug, set the following parameters
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<logger name="com.tibco.tci.sharedresource.sqgsclient.runtime">
<level value="DEBUG"/> </logger>

4. Save the file.

Exporting Logs to a File

Modify the logback.xml file to export plug-in logs to a file.

Procedure
1. Navigate to the TIBCO_HOME\bw\version\config\design\logback directory and open
the logback.xml file.

o Note: When deploying an application in TIBCO® Enterprise Administrator,
you have to navigate to the TIBC0O_
HOME \ bw\domains\mydomain\appnodes\myspace\mynode directory to find
the logback.xml file.

2. Specify the file location by adding the following node to:

<appender name="FILE" class="ch.qos.logback.core.FileAppender">
<file>c/bwe.log</file>
<encoder>
<pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger
{36} -%msg%n</pattern>
</encoder>
</appender>

The file tag defines the location to which the log is exported, and the value is the
absolute path of the file.

o Note: You must add the file name in the file path.

3. Enable export of the logs to a file by adding the following node to the root node at
the end of the logback. xml file:
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<appender-ref ref="FILE" />

<root level="ERROR">
<appender-ref ref="STDOUT" />
<appender-ref ref="FILE" />
</root>

4. Save the file.
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Setting Proxy

The HTTP proxy can be configured through Amazon SQS and SNS Connection in the
Custom Client Config by selecting the Custom option. The following fields are used to
configure HTTP proxy:

Group Field Description
Plug-in HTTP Proxy Proxy Host Required. The proxy host name or its IP address.
Properties
Proxy Port Required. The port on which the proxy server is
running.
Proxy Optional. The user name for logging on to the
Username proxy server.
Proxy Optional. The password for logging on to the
Password proxy server.
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Error Codes

The following table lists the exceptions that are thrown by the plug-in with corresponding

descriptions and resolutions.

Error Code and Error Role Category Description Resolution
Message
BW-AMAZON-SQSSNS- errorRole BW-Plug-in Exception while Correct the
503000 creating shared
. connection shared  resource
Resource exception I
t' , resource definition such
cl:ea |(|;1g connection that it can be
shared resource instantiated.
BW-AMAZON-SQSSNS- errorRole BW-Plug-in Cannot create AWS  Correct the
503001 credentials based shared
Failed t te th on the provided resource
Aal € oscr:gl.e te Keyld and definition such
mazonSQSClien KeySecret, or the that the client
default can be
configuration instantiated.
BW-AMAZON-SQSSNS- errorRole BW-Plug-in  The Amazon Correct the
503002 SQSClient cannot shared
Failed t te th be created resource
Aal € OSCI:?I,G te because the definition such
mazonSQSClien custom client that the client
because the custom . .
i ) o configuration is can be
client configuration is . .
not correctly instantiated.
not correctly .
. configured.
configured.
BW-AMAZON-SQSSNS- errorRole BW-Plug-in  The Amazon Correct the

503003

SQSClient cannot

shared
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Error Code and Error
Message

Failed to create the
AmazonSQSClient
because a Keyld is
provided and a
KeySecret wasn't

BW-AMAZON-SQSSNS-
503004

Invalid Authentication
Type

BW-AMAZON-SQSSNS-
502002

The get operation failed
to return a message for
the reason: "{error}"

BW-AMAZON-SQSSNS-
502003

The put operation failed
to send a message for
reason: "{error}"

BW-AMAZON-SQSSNS-
502005

The create operation
failed to create queue
for the reason: "{error}"

Role

errorRole

errorRole

errorRole

errorRole

Category

BW-Plug-in

BW-Plug-in

BW-Plug-in

BW-Plug-in

Description

be created
because a Keyld is
provided but a
KeySecret is not
provided.

Occurs when
invalid
authentication
type is specified in
the module
property.

The get operation
fails to return a
message. It shows
an error message
displayed by
Amazon SQS

The get operation
fails to return a
message. It shows
an error message
thrown by Amazon
SQS

The create
operation fails to
create a message.
It shows an error
message thrown
by Amazon SQS

Resolution

resource
definition such
that the client
can be
instantiated

Correct the
shared
resource
definition such
that the client
can be
instantiated.

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.
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Error Code and Error
Message

BW-AMAZON-SQSSNS-
502006

The delete operation
failed for reason: "
{error}"

BW-AMAZON-SQSSNS-
502007

The inquire operation
failed for the reason: '
{error}"

BW-AMAZON-SQSSNS-
502020

The create topic
operation failed for
reason:{reason}

BW-AMAZON-SQSSNS-
502021

The publish operation
failed to send a
message for reason:
{reason}

BW-AMAZON-SQSSNS-
502022

The destroy topic
operation failed for
reason: {reason}

Role

errorRole

errorRole

errorRole

errorRole

errorRole

Category

BW-Plug-in

BW-Plug-in

BW-Plug-in

BW-Plug-in

BW-Plug-in

Description

The delete
operation fails. It
shows an error
message thrown
by Amazon SQS

The inquire
operation fails. It
shows an error
message thrown
by Amazon SQS

The create topic
operation fails. It
shows an error

message thrown
by Amazon SQS.

The publish
operation fails to

send a message. It

shows an error
message thrown
by Amazon SQS.

The publish
operation fails. It
shows an error
message thrown
by Amazon SQS.

Resolution

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.

Resolve the
problem based
on the
exception
information
provided.
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ Plug-in for Amazon SQS and SNS Product Documentation page:

e TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS Release Notes
e TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS Installation
e TIBCO ActiveMatrix BusinessWorks™ Plug-in for Amazon SQS and SNS User Guide

How to Contact TIBCO Support
Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

» For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support website.

» For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to TIBCO Support
website. If you do not have a user name, you can request one by clicking Register on
the website.
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How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to

TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, Business Studio, and TIBCO
Business Studio are either registered trademarks or trademarks of Cloud Software Group, Inc. in the
United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SOFTWARE GROUP, INC. MAY MAKE IMPROVEMENTS
AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT
ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of Cloud Software Group, Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2017-2023. Cloud Software Group, Inc. All Rights Reserved.
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